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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
ABOUT THIS MANUAL 1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .T Y P O G R A P H I C A L  C O N V E N T I O N S

This document uses the following typographical conventions: 

• Command and  option  names a ppear in b old type  in de finitions and examples. T he n ames of dire ctories, fil es, machines,
partitions, and volumes also appear in bold. 

• Variable information appears in italic type. This includes user-supplied information on command lines. 

• Screen output and code samples appear in a monospace code type. 

In addition, the following symbols appear in command syntax definitions.

• Square brackets [ ] surround user-supplied optional items. 

• Angle brackets < > surround user-supplied values that are required. 

• Percentage sign % or the construct "C:\" represents a regular Windows command shell prompt.

• Pipe symbol | separates mutually exclusive values for a command argument. 

This symbol denotes important information or values.!
Rev. 05262010 1



A B O U T  T H I S  M A N U A L
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .T R A D E M A R K S  A N D  C O P Y R I G H T S

Microsoft Windows XP, Microsof t W indows CE, Microsoft .N ET, and Microso ft Comp act Fra mework are reg istered trademarks of
Microsoft Corporation.

TWIC is a trademark of the United States Transportation Security Administration (TSA).

PIVCheck is a registered trademark of Cod ebench, Inc. PIVCheck Mobile, PIVCheck Desktop, PIVCheck Plus Mobile, PIVCheck Plus
Desktop, TWICCheck, TWICCheck Plus Edition, OMNICheck, OMNICheck Plus and PIVCheck Certificate Manager are trade marks of
Codebench, Inc.

All other trademarked or copyrighted names mentioned herein are the property of their respective owners.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
TERMINOLOGY 2
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A C R O N Y M S

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D E F I N I T I O N S

• Administrator

An administrator is an individual authorized to manage one or more desktop or mobile biometric terminals. 
Administrators are provided additional functionality to based on their login credentials.

• Cardholder

A cardholder is an individual who has been issued a credential which is supported by our software. For more 
information refer to “Supported Credential Types” on page 8.

Abbreviation Long Form

AIA Authority Information Access

CA Certification Authority

CHUID Cardholder Unique Identifier

CPV Certificate Path Validation

CRL Certificate Revocation List

CRLDP Certificate Revocation List Distribution Points

CTL Certificate Trust List

FASC-N Federal Agency Smart Credential Numbers

FIPS Federal Information Processing Standard

ICC Integrated Circuit Chip

IDN Issuer Distinguished Name

OCSP Online Certificate Status Protocol

PACS Physical Access Control System

PIV Personal Identity Verification

PKI Public Key Infrastructure

QCRL Quick Certificate Revocation List

SCVP Server-based Certificate Validation Protocol

TWIC Transportation Worker Identification Credential

TPK TWIC Privacy Key

VA Validation Authority
Rev. 05262010 3
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TE R M I N O L O G Y
• Certificate Authority (CA)

A certificate authority (CA) is an entity that issues digital certificates to organizations or individuals. The CA is usually 
well known and universally trusted. A CA may authorize other entities to issue certificates on its behalf, thereby 
creating or extending a chain of trust. Certificates contain a digital version of this chain so that software can verify 
each node on the chain of trust is a valid CA, a process called Certificate Path Validation.

• Certificate Revocation List (CRL)

A CRL is a list of certificates that have been revoked before their expiration by a certificate authority.

• Mobile Biometric Terminal

A Mobile Biometric Terminal is a mobile, hand-held reader configured with the following components:

• FIPS 201 compliant smart card reader capable of reading PIV-II compliant cards over its contact or contactless smart card 
interface 

• FIPS 201 compliant fingerprint capture device.

The currently supported models are Datastrip's DSV2+TURBO and DSV3 EasyRead, MaxID’s IDLMAX, DAP’s 
CE3240BWE, MorphoTrak’s MorphoCheck and Cross Match’s Be.U Mobile. These devices, and/or their card and 
biometric components have been certified by GSA for use with FIPS 201 CHUID applications.

• Data Mapping Template

A data-mapping template provides the ability to map the data fields acquired from a PIV card to the fields in a PACS 
personnel and/or card database record.

• Desktop Biometric Terminal

A desktop biometric terminal is a standard desktop PC, integrated with the following components:

• FIPS 201 compliant smart card reader capable of reading PIV-II compliant cards over its contact interface 

• FIPS 201 compliant fingerprint capture device.

• Installer

An installer is a person responsible for installing PIV acquisition hardware and software.

• Online Certificate Status Protocol (OCSP)

The online certificate status protocol (OCSP) defines a series of messages between software applications that need 
to verify whether the issuing CA has revoked an x.509 digital certificate. An OCSP server does not check the validity 
of any of the certificate in the chain of certificates associated with the end entity (certificate in question).

• Physical Access Control System (PACS)

A physical access control system (PACS) refers to an integrated unit of software, data, firmware, microcontrollers, and 
ingress/egress devices that control human access to areas within a facility. A PACS head-end usually consists of one 
or more servers that communicate with field devices to which doors, turnstiles, and access readers are physically 
connected. 

• Personal Identity Verification (PIV)

FIPS 201 Personal Identify Verification is a two-part standard, referred to as PIV-I and PIV-II, respectively:

• defines the processes and infrastructures that are used in establishing a person's identity and issuing them a credential.

• defines technical interoperability requirements for those credentials to be used in a variety of applications.

• Server-based Certificate Validation Protocol (SCVP)

Server-based certificate validation protocol (SCVP) defines a series of messages between software applications that 
need to verify whether the issuing ca has revoked an x.509 digital certificate. An SCVP server checks the validity of all 
4 Rev. 05262010
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. .TE R M I N O L O G Y
of the certificates in the chain of certificates associated with the end-entity and can return additional information to 
enable a relying party (client) to make more intelligent decisions regarding the certificate.

• Transportation Worker Identification Credential (TWIC)

The Transportation Worker Identification Credential (TWIC) is a standard that is intended to address the unique 
needs of transportation workers, most notably within the maritime industry. TWIC breeder documents and biometric 
data are gathered and processed by systems that comply with FIPS 201 PIV-I. TWIC cards are required to be PIV-
II compliant and can be read by any PIV-II compliant smart card reader.

The TWIC standard diverges from the PIV-II standard in that it provides for contactless card-reader biometric data 
exchange, whereas the FIPS 201 PIV-II standard states that biometric data retrieval can only be performed while 
the card is in physical contact with the reader. The two main factors that drive this are:

• TWIC cards are used in high traffic areas, where a mistyped or forgotten PIN creates delays

• a corrosive maritime environment can impact contact-based readers

• TWIC Privacy Key (TPK) (TWIC cards only)

The TWIC privacy key is used to protect cardholder privacy when transmitting biometric templates over a TWIC’s 
contactless interface. An application acquires the TPK from the card's magnetic stripe, the smart card's TPK 
container, or from a server on a network. OMNICheck retrieves this key when the smart card is inserted into the 
contact reader.

• User (Operator)

A user is an individual that has been authorized to operate a mobile biometric terminal. PIVCheck Desktop Edition, 
PIVCheck Mobile Edition and OMNICheck enables its extraction and data import functions after it determines the 
individual logging into the system is authorized to perform user-level functions. 

• Validation Authority

A validation authority is a trusted computer-based service that can verify to a relying party that a digital certificate is 
valid and has not been revoked. A validation authority should always consider the complete certificate hierarchy of 
issuer, intermediate, and trust anchor certificates before it validates the certificate.

The Tumbleweed Validation Authority (VA) has been tested and certified for use with PIVCheck Desktop Edition, 
PIVCheck Mobile Edition and OMNICheck. It can be configured as a full-blown Validation Authority (VA) Responder 
or as a VA Repeater (recommended). In Repeater mode, it will act as a proxy OCSP Responder, caching and 
issuing signed OCSP responses from a trusted Validation Authority within the Federal PKI.
Rev. 05262010 5
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
KEY FEATURES 3
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .P I V C H E C K  M O B I L E  E D I T I O N

PIVCheck Mobile Edition is designed to h elp security personnel to verify cardholder identity and ensure that they possess a val id
credential.

CARDHOLDER VALIDATION
PIVCheck Mobile Edition employs a three-factor authentication to verify a cardholder's identity. The cardholder is first prompted for a
cardholder PIN. If the PIN i s matched, the  cardholder's certificates a nd biometrics are read from the card. The cardholder is then
prompted for a fingerprint. If the fingerprint is matched, the certificates on the card are validated using the configured PKI plug-in.

CARDHOLDER CERTIFICATE VALIDATION
PIVCheck Mobile Edition can ensure that each mandatory and optional X.509 certificate extracted from a PIV ca rd is validated in
several ways including:

• that the current date is between the notBefore and notAfter dates

• that the certificate was issued by a trusted authority

• that the certificate is not revoked

Certificates are val idated using  combinations of loca l and  onli ne queries using OCSP or SCVP.  Fo r completely o ffline certifica te
validation, PIVCheck Mobile Edition can che ck certificates ag ainst previo usly impo rted CRLs. For TWIC app lications, PIVCheck
Mobile Edition also checks a card's FASC-N against the TSA hot list. 

CARD VALIDATION
PIVCheck Mobile Edition issues a  GENERAL AUTHENTICATE challenge to the PI V card ap plet to en sure that it is communica ting
with an authentic card, not a forgery. If configured, PIVCheck Mobile Edition submits the CHUID certificate to a validation authority to
check for revocation.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .P I V C H E C K  P L U S  M O B I L E  E D I T I O N

In addition to  the  co re fe atures of fered by PIVCheck Mobile Edition, PIVCheck Plus Mobile Edition provides the  fol lowing
enhancements.

PACS REGISTRATION
PIVCheck Plus Mobile Edition has the ability to import cardholder data into a PACS. The following information is acquired from a PIV
card:

• Cardholder Photograph

• FASC-N

• Certificate Expiration Date

• First, middle, and last name

• TWIC Privacy Key (TWIC cards only)

• Employee Affiliation

• Card Expiration Date

• Agency Card Serial Number

• Issuer Identifier

• Any other data field stored on the PIV card
Rev. 05262010 7



K E Y  F E A T U R E S
BATCH IMPORT
Using PIVCheck Plus Mobile Edition, a cardholders data can be stored on a mobile biometric terminal and imported into the PACS at a
later time via batch processing.

OPERATOR OVERRIDE 
The PIVCheck Plus Mobile Edition opera tor can  choose not to impo rt the data extr acted from a given PIV card into the P ACS. The
extracted card data is not saved or cached.

IMPORTED FIELD MAPPING
When config ured with a P ACS plug-in, PIVCheck Plus Mobile Edition can map  PIV d ata fie lds to PACS cardholder fields. Vendor-,
product-, and release-specific field mappings and data transformations are specified through the use of data mapping templates.

CERTIFICATE DATA
PIVCheck Plus Mobile Edition inserts PIV authe ntication certifi cates and FASC-N in to a certificate database. If PIVCheck Certificate
Manager is inst alled at the site, these st ored PIV authe ntication certificates are re -validated against a  CRL , OCSP/SCVP
responder/repeater, or the TSA TWIC hot list on a periodic basis.

Through the use  of d ata ma pping templa tes, stored a uthentication certif icates can be  associated  with P ACS badg es. This g ives
PIVCheck Plus Mobile Edition the ability to deny cardholders with revoked credentials access to controlled areas within a secured facility. 

DISTRIBUTED CONFIGURATION
PIVCheck Plus Mobile Edition includes a PC-based software component called a PACS plug-in. This software can be installed on the
same computer as the PACS or on a separate computer, if necessary. In  addition to se rving as a  bro ker be tween mobile b iometric
terminals and the PACS, the PACS plug-in maintains a site-wide configuration profile for all mobile biometric terminals, making it easy to
commission new mobile terminals.

CENTRALIZED AUDIT OPTION
With PIVCheck Plus Mobile Edition configured with the Audit option, event logs from each mobile biometric terminal are uploaded to a
central database so that audit reporting can be performed from a central location.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S U P P O R T E D  C R E D E N T I A L  T Y P E S

• Transportation Worker Identification Credential (TWIC)

• Personal Identity Verification (PIV, CAC EP)

• Common Access Credential (Legacy CAC) 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SYSTEM ARCHITECTURE 4
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .H A R D W A R E  C O N F I G U R A T I O N

A typical hardware configuration is shown below. A smart card reader, fingerprint sensor, and randomized PIN pad are integrated into
a weather-resistant, ruggedized PDA and are referred to as a mobile biometric terminal. The terminal software prompts the cardholder
and operator at each step of the data acquisition process. The mobile biometric terminal collects the data, validates a PIV car d with
the PKI plug-in or TSA hotlist, and uploads to the PACS (if one exists).

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S O F T W A R E  C O N F I G U R A T I O N

PIVCheck Mobile Edition can be configured as a stand-alone identity validation system or integrated with a PACS. As a result, there
are two possible baseline software architectures.

PIVCHECK MOBILE EDITION
PIVCheck Mobile Edition runs independently with no communication with a  PACS server. Cardholder identity is val idated using the
smart card reader, PIN pad, and fingerprint scanner installed within the mobile biometric terminal.

Depending on the environment, the validity and authenticity of a PIV card is veri fied through communication wi th an OCSP/SCVP
responder/repeater or TSA Hotlist. Other than the event logs, no credential information is stored or forwarded.

Each mobile biometric terminal is configured separately using an administrative account specific to that terminal.

PIVCheck PACS Server PIVCheck Plus Mobile Client

PACS
(Physical Access Control System)

Supported OS:
Windows 7 Ultimate
Windows 7 Professional
Windows Vista Ultimate
Windows Vista Business
Windows Server 2008
Windows Server 2003 R2
Windows XP SP3

MaxID Model: IDLMAX
DAP MICROFLEX Model: CE3240BWE
Datastrip DSV2+
Datastrip DSV 3 Model: 2012-00001 
Crossmatch Be.U Mobile SMC-800 Series
Sagem MorphoCheck
Rev. 05262010 9



S Y S T E M  A R C H I T E C T U R E
PIVCHECK PLUS MOBILE EDITION
PIVCheck Mobile Edition includes a server-based software component, called a PACS plug-in, which serves as a broker between mobile
biometric terminals and the PACS. The functions supported by the  PACS plug-in include PACS registration, batch import of cardholder
data, mapping data from PIV dat a fields to PACS cardholder fields, and associating PIV cards wi th PACS badges. In addition, the PKI
data stored by the PACS plug-in can be used by the Certificate Manager to periodically check for revoked credentials.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .H A R D W A R E

The PIVCheck Mobile Edition biometric terminal combines a contact and contact-less smart card reader, a 500 DPI fingerprint sensor for
instant matchin g to  a biometric te mplate, and  a color dig ital touch-screen display housed in a comp act han dheld uni t wh ich wei ghs
approximately two pounds. The mobile biometric terminal supports internal wireless communication for data and fingerprint transmission
and also identity search and verification against a back-end system.

Specifications for the PIVCheck Mobile Edition biometric terminal:

Component Description

Random Access Memory Minimum of 32 MB RAM. Recommended 128 MB RAM or greater.

Persistent Memory Minimum of 256 MB Internal CF

Monitor

Color digital transflective touch screen with stylus.

Supported dimensions:

• 240 horizontal x 320 vertical (portrait)
• 320 horizontal x 240 vertical (landscape)
• 640 horizontal x 480 vertical (landscape)
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S O F T W A R E

FIPS 201 PRODUCT COMPLIANCE
This product, when used with PIVCheck Plus Mobile Edition and the PIVCheck Certificate Manager complies with the following FIPS
201 Approved Product List category:

FIPS 140-2 LEVEL 1 REQUIREMENT FOR PIVCHECK MOBILE EDITION
Several FIPS 20 1 approved product categories involve the use of cryptography.  F or those operations, PIVCheck software invokes
functions sup plied by Mi crosoft's Cryptographic API and  Cryptographic Pri mitives Library.  To mee t GSA App roved Produ ct Li st
requirements, certain cryptographic functions can only be provided by cryptographic modules that have been certified at FIPS 140-2
Level 1 or better.  For APL compliance, PIVCheck Mobile Edition must be deployed on one of the following operating systems:

Microsoft Windows operating systems and FIPS 140-2 certifications

Fingerprint Sensor Must be FIPS 201 Approved Product List (APL) certified. http://fips201ep.cio.gov/apl.php

Biometric Matching Algorithm Must be FIPS 201 Approved Product List (APL) certified.

Smart Card Interface
Contact interface - Must be FIPS 201 Approved Product List (APL) certified.

Contact-less interface - Must be FIPS 201 Approved Product List (APL) certified.

Wireless Protocol WiFi 802.11b/g

Component Description

Operating System Requires Microsoft® Windows® CE 5.0 and .NET Compact Framework 2.0 or greater.

Signature Algorithms

RSA with SHA-1 and PKCS v1.5 padding

RSA with SHA-256 and PKCS v1.5 padding

RSA with SHA-256 and PSS padding

ECDSA with SHA-256, and ECDSA with SHA-384a

a. non-FIPS 140-2 validated implementation

Category Certificate

Caching Status Proxy #473

CHUID Authentication System #485

Authentication Key Reader #474

Operating System Validated Version Certificate

Windows CE 5.0 and 5.01 5.00.911762 and 5.01.01603 #560
Rev. 05262010 11
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SOFTWARE INSTALLATION 5
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I N S T A L L A T I O N  O P T I O N S

PIVCheck Mobile might not be pre-installed on the mobile biometric terminal. If a connection to the internet is available, then refer to
“Downloading PIVCheck Mobile directly on the Mobile Terminal” on page 14. If an  internet conn ection is no t avai lable, refer to
“Installing PIVCheck Mobile File from a Flash Drive” on page 18.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I M P O R T A N T  N O T I C E

Please no te that the scree n cap ture imag es sho wn i n this manual are for illustrative purp oses o nly. Screen icons may app ear
differently if you are using a device which uses a d ifferent screen orientation or a device which supports a higher screen resolution.
The following screen capture images were acquired from a mobile biometric terminal which has a screen resolution of 240 x 320 and
is using the portrait layout.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .P O W E R I N G  U P

Due to the variances of hardware configurations, please refer to the user manual for detailed instructions on powering on 
your mobile biometric terminal.!
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S O FT W A R E  I N S TA L L A T I O N
D O W N L O A D I N G  P I V C H E C K  M O B I L E  D I R E C T L Y  O N  T H E  M O B I L E  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .T E R M I N A L

To use this method, you must have an Internet connection and a user name and password to access the Codebench general download
site. If you have never used Internet Explorer from your mobile biometric terminal, it may need to be configured for Internet access. 

Launch Internet Explorer and tap View.

Tap on Internet Options at the bottom.
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. .S O FT W A R E  I N S TA L L A T I O N
When the dialog appears, tap on the Connection tab. Check the Use LAN (no autodial) option.

If you are required to use a proxy server then check the Access the Internet using a proxy server option and supply the addressing
information for your site.

Tap the OK button to save the configuration options.

Now you are ready to download the PIVCheck Mobile software. Type the following URL into the browser's address bar: 
http://www.pivcheck.com/cabs/

An authentication dialog will be displayed. 
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S O FT W A R E  I N S TA L L A T I O N
Enter your User Name and Password into the appropriate fields and tap the OK button. If the information is correct, then an options dialog
will be displayed: 

Choose the options as sho wn above and tap OK. The new PIVCheck Mobile Edition executable file will be downloaded to the \Temp
folder on the terminal. 

Tap the OK button to start the download. 
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. .S O FT W A R E  I N S TA L L A T I O N
When the file download is complete, close Internet Explorer and tap on My Device and navigate to the \Temp folder. 

Double-tap on the PIVCheckMobileEdition 1.X.XX.X.exe file and follow the installation wizard. 
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S O FT W A R E  I N S TA L L A T I O N
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I N S T A L L I N G  P I V C H E C K  M O B I L E  F I L E  F R O M  A  F L A S H  D R I V E

• Copy the PIVCheck Mobile Edition executable file onto the flash drive. 

• Power up the mobile biometric terminal.

• Insert the flash drive into one of the standard USB ports located on the mobile biometric terminal. 

• Double-tap the My Device Icon. The flash drive will appear as a Hard Drive in this directory.

• Double-tap on the Hard Drive directory to reveal the PIVCheck Mobile Edition executable file. Copy the executable file from the My 
Device > Hard Disk directory to the My Device >Temp directory.

• Double-tap the executable file and follow the installation wizard.

This completes the installation.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
CONFIGURING THE SYSTEM 6
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .L I C E N S I N G  T H E  S O F T W A R E

1 Once the Windows CE operating system boots, use your stylus to double-tap the shortcut to PIVCheck Mobile Edition icon.

2 Enter the default operator User ID (admin) and Password (password) using the input panel. 

Your system integrator may have changed the default administrative User ID and Password from the Codebench factory 
defaults located above. Please consult your system integrator's documentation.!
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C O N F I G U R I N G  T H E  S Y S T E M
3 Press the OK button to accept the password and launch the PIVCheck Mobile Edition splash screen. 

4 If your software has not yet been licensed, the splash screen will be replaced with the License Key Download dialog. 

You can disable the splash screen by un-checking the checkbox in the upper left-hand corner.!

An active internet 
connection is required 
when Download 
license key is 
tapped.

Press here to 
continue with a trial 
license or to enter 
your license 
manually.
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. .C O N F I G U R I N G  T H E  S Y S T E M
TRIAL LICENSE
If you wish to evaluate the software for 30 days, press the Download license key button. The trial license consists of a fully functional
PIVCheck Mobile Edition. If you have purchased and registered the product then the online licensing service will reissue your fu ll
license, and the Licensed successfully installed pop-up will be displayed.

ENTER YOUR LICENSE MANUALLY
If you do not have an internet connection or you need to license your software manually, press Continue without a license. The main
application will load and display the Home screen. The following steps shows how to add your license key manually. 

Enter the letters, numbers and dashes that make up your license key using the input panel. If you mistype a character, use the delete
key in the upper right-hand corner of the input panel to erase your input, then re-enter the correct character.

The license key field is now po pulated, indicating you have successfully licensed PIVCheck Mobile Edition. Press the Exit button to
return to the Application Configuration dialog.

PIVCheck Plus Mobile Edition is not available in a trial version.  To enable additional features such as Plus or Audit, please 
contact the Codebench sales team who can enable those features ahead of time for the duration of the trial period.

If PIVCheck Mobile Edition software has been pre-installed by the terminal manufacturer, then the license key you received 
with your mobile biometric terminal is synched with the device’s unique system ID.

!

!
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C O N F I G U R I N G  T H E  S Y S T E M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C H A N G I N G  T H E  A D M I N  P A S S W O R D

Out of the box the de fault username is admin, and the default password is password. It is stron gly recommended that you change the
administrative password immed iately upon receiving a  new mobile b iometric terminal. To change the password, re-launch PIVCheck
Mobile Edition. After the splash screen displays, you will see the PIVCheck Mobile Edition Login dialog. 

For each field, use your stylus to set the cursor position, and then use the input panel to enter your current password and new password.
Next, tap the Tab key which dismisses the input panel and reveals the OK and Cancel buttons. Press the OK button to login with your
new password and display the Home tab.

Tap here to 
change your 
password.
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. .C O N F I G U R I N G  T H E  S Y S T E M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C O N F I G U R I N G  T H E  P A C S  P L U G - I N  O N  Y O U R  P C  ( P L U S  O N L Y )

PACS Service i s a generic term for the ve ndor-specific PACS plug-in tha t b rokers communication between your mob ile biometric
terminal and the PACS. 

AUTHORIZING CLIENT CONNECTIONS
To authorize a client, open the PACS Service plug-in on the server click Tools > Manage Clients. A list of authorized client System IDs
will be displayed. If the client you are configuring is not displayed, click the Add button and a dialog will be displayed:

The client's System ID will be added to the list. The client will now be able to connect to the PACS Service.

Fill in the 
necessary 
information, 
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C O N F I G U R I N G  T H E  S Y S T E M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S Y N C H R O N I Z E  C O N F I G U R A T I O N  ( P L U S  O N L Y )

The fastest way to set u p the mobile biometric terminal is to synchronize the terminal's local configuration with the profile stored by the
PACS Service. Tap the Home Tab > Tools tab, then tap the Synchronize Configuration… button. Verify that the host name and ports are
correct. 

You can test your connection first, if desired.

Select which settings you wish to download and tap the Start button to commence downloading the configuration profile from the PACS
service.
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. .C O N F I G U R I N G  T H E  S Y S T E M
When the configuration has been fully downloaded, the following message will be displayed:
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C O N F I G U R I N G  T H E  S Y S T E M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .M A N U A L L Y  C O N F I G U R I N G  T H E  P I V C H E C K  M O B I L E  D E V I C E

To configure your mobile biometric terminal, tap the Configuration tab. The five sub-tabs which appear are labeled Plus, App, Blacklists,
Users and Door Control. We will address each configuration area in turn.

PLUS TAB (PLUS ONLY)

Select the Plus tab to view the PACS service configuration dialog. 

This section assumes you have successfully configured your mobile biometric terminal to communicate over a LAN, WiFi, 
or GSM network. To configure your mobile biometric terminal, refer to “Authorizing Client Connections” on page 23.!
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. .C O N F I G U R I N G  T H E  S Y S T E M
R E G I S T R A T I O N  H A N D L I N G
If Prompt for Registration is checked, then PIVCheck Plus Mobile Edition will always prompt the user to register the card information
into the PACS, save the information locally, or cancel. If not checked, PIVCheck Plus Mobile Edition will attempt to register the card
information automatically.

S E R V E R  A D D R E S S
The server address is the IP address of your PACS Service. The PACS server interprets data sent from the terminals, converting it to
a format understood by the PACS. The first time the application is run, the Server IP is normally set to localhost. Enter the IP address
or hostname of your PACS Service using the Input Panel.

S E R V E R  P O R T
Unless otherwise instructed, do not change the va lues for th e Server port field. Press th e Test... button to  connect to  your PACS
Service. If the connection was successful, you will see the following message.The server looks up the client's System ID and, if found
sends back the encryption key that the client should use to encrypt offline transactions. If the connection was successful, you will see
the following message. 

The server looks up the client's System ID and, if found sends back the encryption key that the client should use to encrypt offline
transactions.
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C O N F I G U R I N G  T H E  S Y S T E M
PACS CONNECTION FAILURES
This section lists some of the most common conditions that result in a failure when the Test button is tapped.

C L I E N T  N O T  A U T H O R I Z E D  
If the client has not been added to the list of authorized clients, the following will be displayed. On the PACS Service Administration GUI,
use the Tools > Manage clients option to add the client to the server database. Once completed, tap the Test button again.

I N C O R R E C T  S E R V E R  I P  A D D R E S S  O R  N E T W O R K  R O U T I N G  P R O B L E M
You will see the following error dialog if your attempted connection was unsuccessful because the server IP or name was incorrect or the
request could not be routed to the server. 
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. .C O N F I G U R I N G  T H E  S Y S T E M
S E R V E R  E X I S T S  B U T  P A C S  S E R V I C E  I S  N O T  R U N N I N G
Please refer to the PACS Plug-in Administration Guide for your PACS for instructions on how to setup your PACS Service.

O F F L I N E  F I L E  F O L D E R
A default offline file location of <Application Folder>\offline\ is defined when you install PIVCheck Mobile Edition. If you
wish to change the name or location of this folder, press the Browse button to view the Folder Selection dialog.
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C O N F I G U R I N G  T H E  S Y S T E M
A folde r browser wil l be d isplayed. The  initia l locatio n is set to the  currently selected  folder whi ch shoul d be su fficient fo r most
applications.

Navigate to a different portion of the file tree and select the new device and folder if you  wish to relocate the offline file. Tap Select to
accept the change.

Press the Save button within the Plus tab to store your server URL and display the following popup dialog.
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. .C O N F I G U R I N G  T H E  S Y S T E M
When the configuration has been encrypted and stored on the device the following message is displayed:

Press the OK button to return to the Home tab.

APPLICATION TAB
PIVCheck Mobile Edition contains several configurations located under the App tab. These configurations include Fingerprint options,
PIN options, Audit log folder location, and Error log folder location.
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C O N F I G U R I N G  T H E  S Y S T E M
F I N G E R P R I N T  O P T I O N S

V E R I F Y  F I N G E R P R I N T

If the Verify Fingerprint box is checked the cardholder will be prompted to present an index finger for on-card matching. If this box re-
mains unchecked, the cardholder will not be prompted to present his or her finger for a fingerprint scan, the fingerprint data will not be 
read from the card and the fingerprint data will not be stored in the credential database.

F I N G E R P R I N T  M A T C H  T H R E S H O L D

This parameter causes PIVCheck Mobile Edition to determine the minimum score th at is output by th e biometric te mplate matcher in
order to reduce the incidence of fa lse rejections as well as fa lse matches. This parameter is speci fic to th e matcher installed on the
mobile biometric terminal. The first two columns in the table below is shows the different combinations of mobile biometric terminals using
the bi ometric ma tcher purcha sed and  inst alled. The third colu mn sh ows th e low est reco mmended threshold to set for your
device/matcher combination.

Each template matcher uses its own scale for scoring the degree that two templates match each other.

L I M I T  F I N G E R P R I N T  M A T C H  R E T R I E S

Checking this optio n will cause  PIVCheck Mobile Edition to re ject any ca rdholder af ter a use r-defined number of bi ometric matching
attempts.

F I N G E R P R I N T  M A T C H  R E T R I E S

Use the virtual keypad to set the number of retries to the desired number.

L I C E N S E  ( F I N G E R P R I N T  T E M P L A T E  M A T C H E R )

Verification without biometric matching is not recommended.

Mobile Biometric Terminal Biometric Template Matcher Lowest Recommended Threshold

DAP CE3240BWE Innovatrics 12300

Datastrip's DSV3 Identix 10

Datastrip's DSV2+TURBO Identix 10

Datastrip's DSV2+TURBO NEC 1400

Cross Match Be.U Mobile Innovatrics 12300

MaxID IDLMAX Innovatrics 12300

The lower the threshold as compared to the recommended threshold, the greater the risk of false matches. The higher the 
threshold, the greater risk of false rejections. It is suggested to test out your device within a controlled group to find a 
satisfactory median threshold and to calibrate your unit regularly.

Applies to mobile biometric terminals for which the fingerprint matcher license is not preinstalled.

!

!

!
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. .C O N F I G U R I N G  T H E  S Y S T E M
If PIVCheck Plus Mobile Edition is being used, and a fingerprint matcher license has been purchased, then press the License button.

Press the Browse button, then navigate to the location of the license file which was transferred to your mobile biometric terminal from
your PC.
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C O N F I G U R I N G  T H E  S Y S T E M
Select the fingerprint matcher license file, then press OK. Your fingerprint matcher is now licensed.

A U D I T  L O G  F O L D E R
The l ocation of th e audit log is co nfigurable. A d efault of fline file  loca tion o f <Application_Folder>\audit\Activity.paf is
defined when you install PIVCheck Mobile Edition. If you wish to change the name or location of this folder, press the Browse button to
view the folder selection dialog.

Navigate to a different portion of the file tree and select the new device and folder. Tap Select to accept the change.

The file name will always be named Activity.paf.!
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. .C O N F I G U R I N G  T H E  S Y S T E M
E R R O R  L O G  F O L D E R
The error log contains information about errors that the PIVCheck Mobile Edition application was unable to handle cleanly. These are
generally unexp ected con ditions such as a  missing d river, o r ce rtain n etwork errors, or issue s with smart cards. Each li ne of
information corresponds to a single trouble ticket and consists of the following columns:

• Operator's User Name

• Time

• Unit ID

• Error Description

• Exception Message

• Contact E-mail

• Contact Phone Number

The location of the error log is configurable. A default offline file location of <Application Folder> \errorlog\Errors.txt is
defined when you install PIVCheck Mobile Edition. If you wish to change the name or location of this folder, press the Browse button
to view the folder selection dialog.

Navigate to a different portion of the file tree and select the new device and folder if you wish to relocate the error log file. Tap Select
to accept the change.

C O N F I G U R A B L E  C O N T A C T  I N F O R M A T I O N
The contact E-mail and contact phone number fields are configurable by editing or copying the following file, contactinfo.txt into
the  PIVCheck Mobile Edition folder. The format of this file is:

helpdesk@somewhere.com,(703) 555-1212
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C O N F I G U R I N G  T H E  S Y S T E M
A U T O M A T I C  R O L L O V E R
The current day's trouble ticket file is named Errors.txt. However, as of Release 1.2.18.0, this file is created each day after renaming
the previous days' file to Errors. <yyyymmdd>.txt where yyyymmdd are the year, month, and day corresponding to the fil e's entries.
The application stores up to ten (10) days of files in this manner. Files older than 10 days are removed from the folder.

DEVICES TAB
If PIVCheck detects that there are multiple smart card readers or fingerprint capture devices, the Devices tab will be displayed.

BLACKLIST PLUG-INS
For more informati on refer to the Codebench Blacklist_Plug-in_User_Guide.pdf. This manual is stored in the PIVCheck Mobile Edition
program files directory. 
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. .C O N F I G U R I N G  T H E  S Y S T E M
USERS
For security reasons, it is not recommended to perform identity verification or to import data as an administrative user. The Users tab
allows you to set up user accounts to enable individual access to the device. Each user can have his or her login account.

U S E R  I D
Create a unique User ID for each operator and administrator who will be using this device. The user ID must be at least 2 characters
long.

P A S S W O R D
Create a secure p assword fo r ea ch operator an d administrator who  will be usin g th is device. The  password must be  at lea st 8
characters long.

R O L E
Select the role this user will play. The two options are operator and administrator. An administrator has complete control over all the
configuration settings on the mobile device. An operator has limited control over the mobile device and its settings. Below is a li st of
the operator roles:

• Scan and validate PIV and TWIC cards.
• View cardholder photo.
• View cardholder information.
• View cardholder events.
• View the About tab.
• Batch import of audit information.
• Export Audit logs.
• Change logging level.
• View software license information.
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C O N F I G U R I N G  T H E  S Y S T E M
DOOR CONTROL (OPTIONAL)
The Door Control option provides an additional way to validate a PIV card. If the card is completely validated and the cardholder's identity
has been con firmed, a Wi egand protocol  message is sent over the  network to  a Wiegand data con verter. The  converter transforms
network messages into Wiegand output, producing the same wire protocol expected from a typical PACS reader. Two typical use-case
scenarios are shown below.
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. .C O N F I G U R I N G  T H E  S Y S T E M
D O O R  C O N T R O L  C O N F I G U R A T I O N  F O R M
The door control configuration form is shown below.

PIVCheck Mobile Edition simply reports the a ppropriate card number to the  panel. The access control p anel or its host ultimately
decides whether a door or gate should be unlocked. 

E N A B L E  D O O R  C O N T R O L

By checking this option, PIVCheck Mobile Edition will automatically send a Wiegand card number to the specified PACS panel. If the
option is unchecked, no attempt is made.

C O N V E R T E R  I P

This is the  IP add ress of the Wiegand converter connected to the  PACS panel. Ne twork-based panels usually have  their own IP
address.

T E S T

Click this button to send a test message to the Wiegand converter. The test message does not include a card number.

P O R T

This is the TCP port on which the converter is configured to listen for messages.

T Y P E

Two categories of card messages are supported:

• FASC-N or derivatives

• PACS card numbers
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C O N F I G U R I N G  T H E  S Y S T E M
F A S C - N S  A N D  D E R I V A T I V E S

FASC-Ns are no rmally sent to p anels that su pport newer PACS readers such as HID iClass®. The ability to  send FASC-Ns to PACS
panels is sup ported on both PIVCheck Mobile Edition and PIVCheck Plus Mobile Edition. The following FASC-N Wiegand formats are
available:

• 200-bit

• 75-bit GSA

• 75-bit TSA

• 64-bit

• 48-bit 

P A C S  C A R D  N U M B E R S

A PACS card number can be sent to the access panel after a person has been validated. This allows a site to use FIPS 201 credentials
to unlock doors on a legacy PACS system without upgrading access panel firmware in order to support processing FASC-Ns. The ability
to support PACS card numbers is limited to PIVCheck Plus Mobile Edition. The PIV card must be pre-registered with PIVCheck so that
the logical link between FASC-N and PACS card has been established.

The following PACS card Wiegand formats are available:

• 26-bit

• 34-bit

• 36-bit

• HID Corporate 1000

• CASI 3701

• CASI 3702

Additional custom formats can be added as needed.

Although it is best to manage door control from the PACS Server and use the Synchronize Configuration tool to download the correct
formats for the correct PACS panels, door control functionality can also be customized locally on the mobile client.

B I T  F O R M A T

For PACS card number formats, the bit format string shows how card number will be split into site codes and card numbers. 

P A R I T Y  F O R M A T

The parity format shows which bits will be used in the calculation of odd and even parity.

D E L A Y

If you intend to use the  door control to send Wiegand reads after PIVCheck Plus registers a new ca rd or cardholder, you may need to
impose a delay to allow the card information to propagate from the PACS to the panel. If you are not registering a card into the PACS and
are simply using PIVCheck as a validation tool, set this to zero.
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. .C O N F I G U R I N G  T H E  S Y S T E M
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C O M M U N I C A T I O N S  S T A T U S  I N D I C A T O R S

The lower right portion of the events tab contains indicators for the last communications for the PACS server (PIVCheck Plus Mobile
Edition only) and the validation authorities.

The meaning of the indicators are as follows:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S A V I N G  Y O U R  C O N F I G U R A T I O N

Press the Save button to store your application choices. Press OK to return to the Home tab.

 Last communications attempt with PACS service was successful.

 Last communications attempt with validation authority successful.

 Communications attempt with PACS service has not been attempted.

 Communications attempt with validation authority has not been attempted.

 Last communications attempt with PACS service was unsuccessful.

 Last communications attempt with validation authority was unsuccessful.
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This page is intentionally left blank.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
IDENTITY VERIFICATION 7
The PIVCheck Mobile Edition application employs a  three-factor a uthentication process to  validate a  cardholder - something you
have, something you know, and something you are. The identity authentication process is described in detail within this chapter.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S O M E T H I N G  Y O U  H A V E  ( P I V  C R E D E N T I A L )

When PIVCheck Mobile Edition is ready to va lidate a PIV or TWIC card, the first icon in the th ree-factor authe ntication pro cess,
representing the integrated card reader, will appear in color.

The "Something You Have" requirement is met by the fact that a valid  PIV or TWIC card has been inserted into the mobile biometric
terminal and the card has properly responded to a cryptographic challenged issued by the PIVCheck software. However, no personal
information can be read from this card until "Something You Know", the cardholder's PIN, has been entered to unlock the card. The
information needed to fully authenticate the cardholder requires data that is protected by the cardholder's PIN.
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I D E N T I T Y  VE R I F I C A T I O N
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S O M E T H I N G  Y O U  K N O W  ( K N O W L E D G E  O F  P I N )

Once PIVCheck Mobile Edition detects an identity card, a virtual PIN p ad is displayed, prompting the cardholder to enter his or her PIN.
Note that the numbers on the PIN pad are randomly arranged and is rotated to support the point of view of a cardholder. 

The PIN pad can be transposed to support the point of view of the operator by pressing the circular blue arrow.

If a PIN is mistyped, individual characters can be erased using the left-pointing arrow (<). All characters in the input field can be erased
using the erase button (<<).
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. .I D E N T I T Y  VE R I F I C A T I O N
Once the PIN is entered and matched with the PIN recorded on the card, PIVCheck Mobile Edition extracts the fingerprint templates
and all X.509 certificates from the card. 

PIN FAILURE
If the PIN entered by the cardholder cannot be matched against the PIN stored on the card, a popup dialog informs the cardholder the
PIN has failed, and will offer a re-try. 

Select Yes to redisplay the virtual PIN pad and allow the cardholder to re-enter his or her PIN. 

PIVCheck Mobile Edition will be unable to perform any further processing on a card for which the number of failed PIN 
attempts exceeds the maximum number of match attempts configured on the card. Once all the retries have been 
exhausted, the card's PIN can only be reset by the card issuer. The card issuer is the facility you acquired your card from.!
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If the NO button is selected, the Events tab confirms the cardholder is not authenticated. 

Once the card is removed, the card reader icon re-appears in color, signaling the system is prepared to validate a new card.

PIN MATCH
If the PIV PIN is valid all of the information is extracted from the smart card.  This includes the following:

• CHUID
• Card Authentication Certificate
• Card Holder Facial Image and digital signature
• Card Holder Fingerprints and digital signature
• Key Management Certificate
• PIV Authentication Certificate
• Printed Information
• Security Object
• TWIC Privacy Key Buffer (if TWIC applet is present) 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S O M E T H I N G  Y O U  A R E  ( B I O M E T R I C  A T T R I B U T E S )

If the PIN is valid, and the verify fingerprint checkbox was selected during application configuration, a popup dialog prompts the user
to help the cardholder place his or her finger on the fingerprint platen. Once a fingertip is detected, PIVCheck Mobile Edition prompts
the integrated fingerprint reader to capture a live fingerprint. 

FINGERPRINT MATCH
After a few seconds, the biometric produces a fingerprint template from the scanned image. This template is then matched against
both fingerprint templates stored on the smart card. If the  generated template matches ei ther of the two stored  on the  card the n a
match is declared.

S C O R I N G
The decision as to whether a cardholder's fingerprint template matches is somewhat arbitrary since different manufacturers' matching
algorithms produce scores which must be interpreted by the application. The minimum score produced by a matching algorithm in
which a biometric match truly occurred is call ed the fingerprint match threshold. Virtually every template matching algorithm uses a
different scoring system.

F I N G E R P R I N T  M A T C H  T H R E S H O L D
The fingerprint match threshold can be adjusted on the App tab. For the NEC template matcher 1400 is an acceptable threshold. For
the Identix template matcher 10 is an acc eptable threshold. For important configuring information and to determine which template
matcher is licensed, refer to “Fingerprint Options” on page 32.
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FINGERPRINT MATCH FAILURE
If the cardholder's fingerprint is not matched, a popup dialog informs the operator the scanned fingerprint did not match the fingerprint
template stored on the card. Tap the Yes button to redisplay the Present Fingerprint dialog.

If you tap the Yes button, the cardholder can present their finger again. This can repeat for as many retries are available. If you tap the No
button, both the Events tab and the Not Authenticated icon confirms the cardholder is not authenticated.

If the maximum number of retries has been reached, the following message will be displayed.

The events window will display the sequence of attempts.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C E R T I F I C A T E  V A L I D A T I O N

If th e ca ptured fing erprint ma tches the fingerprint on the card, or the Verify Fingerprint option  was left unch ecked duri ng system
configuration, the card's certif icates are verified using full PKI vali dation including checking the revocation status against an OCSP
responder or repeater. For TWIC cards, the card's FASC-N is checked against the TSA hot list.

THE CARD DATA WINDOW
Once a cardholder's certificates have been validated, the Card Data window displays the cardholder's photograph, first, middle, and
last name, FASC-N, GUID, Expiration Date, and other user-configurable data.

THE APPLICATION EVENTS WINDOW
The Application Events window displays a list of system events associated with system configuration and the validation of a PIV card.
Event fields include the time logged, the message type (Info or Error) and a brief description. The window includes a Clear button that
can be used to clear the window of event messages. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I D E N T I T Y  A U T H E N T I C A T I O N

Once a card's certificates are verified, the fourth icon across the top of the display becomes a green check, indicating the cardholder 
has been successfully authenticated. 

DISPLAYING CARDHOLDER DATA
Three sub-tabs under the Home tab are available to support the PIVCheck Mobile Edition operator: Photo, Info, and Events.
Rev. 05262010 49



I D E N T I T Y  VE R I F I C A T I O N
P H O T O  T A B
Once a cardholder's certificates have been validated, the Photo tab displays the cardholder's photograph, first, middle, and last name.

I N F O  T A B
The Info tab displays the text information  stored on a vali dated PIV card, including the first, midd le, and last name, FASC-N, GUID,
Expiration Date, and other user-configurable data.
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E V E N T S  T A B
The Events tab displays a list of system event s associated with s ystem configuration and the va lidation of a PIV car d. Event fields
include the time logged, the message type (Info or Error) and a brief description. The window includes a Clear button that can be used
to clear the window of event messages. 

By default, PIVCheck Mobile Edition logs system messages to the logs sub-directory within the installation directory. It is 
sometimes useful to refer to this log when attempting to troubleshoot system errors. Refer to your PACS Plug-in 
Administration Guide for guidance on configuring the system messages captured in the logs directory.!
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .P A C S  R E G I S T R A T I O N  ( P L U S  O N L Y )

With the Plus option installed, three registration options are available:

• The operator may attempt to register the cardholder with the PACS
• The operator may save the cardholder's credentials locally
• The operator may choose not to register the cardholder

REGISTERING THE CARDHOLDER
To regi ster a card holder on the P ACS, sele ct the first checkb ox on th e Register t ab an d press the  Ok button. If the  cardholder is
registered successfully, a confirmation message appears in the Events tab.

Once the card is re moved, the Photo and  Info t abs are  cleare d. The  card re ader i con re -appears in co lor, signaling the system is
prepared to validate a new card.
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SAVING CREDENTIALS LOCALLY
To save a cardholder's credentials  locally, select the second checkbox on the Register tab and press the Ok button. A co nfirmation
appears in the Events tab, indicating the cardholder information was successfully stored in a locally encrypted file.

Once th e card is removed, the Photo an d Info t abs are cleare d. T he card  reader ico n appe ars in colo r, sign aling th e system is
prepared to validate a new card.

CANCELING REGISTRATION
To cancel (skip) ca rdholder registration, select the thi rd checkbox and press the Ok button. As a result, a red system message is
displayed in the Events tab.
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USER FIELDS
PIVCheck Plus Mobile Edition allows administrators to create customized data entry fields known as User fields. Once a new User field is
defined in your PACS data mapping template and downloaded using the Tools tab on the mobile biometric terminal, it appears as a new
dialog after the Ok button is tapped on the Register tab.

User field s represent a powe rful technique fo r capturing ad ditional cardho lder da ta. On e useful example is associatin g th e PIV
credentials of a new cardholder with the cardholder's existing PACS badge, as expressed in the following use case.

A User field that supports the above use case appears below. Once this User field that maps to this dialog is added to the PACS Service
data mapping template, and downloaded to the biometric terminal, the cardholder will be prompted for his or her PACS badge during the
process of registration. Once the text field is filled out, and the OK button on the dialog is pressed, the cardholder's PACS badge will be
uploaded to the C ertificate Manager database along with the cardholder's credentials, or cached locally for batch pro cessing at a later
time.

Please refer to your PACS Plug-in manual for a detailed description on how to define User fields.

The Certificate Manager can also be configured to notify the PACS when the credentials of an existing cardholder have been 
revoked. This does not require a User field, as the cardholder's PACS badge has already been captured in the cardholder's 
PACS personnel record. 

!

During PACS registration, a new cardholder is prompted for his or her PACS badge via a User field. Both the credentials
and the PACS badge of the cardholder are recorded in the Certificate Manager database. During the process of credential
re-validation, the Certificate Manager detects the cardholder’s credentials have been revoked. As a result, the Certificate
Manager retrieves the cardholder’s PACS badge and notifies the PACS. This allows the PACS to d eny the cardholder
access to controlled areas within the facility. 

!
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Just as during normal registration, a confirmation message will appear in the Ap plication events window, letting the operation know
the operation was successful.

Once th e card is removed, the Photo an d Info t abs are cleare d. T he card  reader ico n appe ars in colo r, sign aling th e system is
prepared to validate a new card.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
TOOLS 8
This chapter p rovides detailed information  fo r the  configuration o f the fol lowing li st o f tools contained within the PIVCheck Mobile
Edition application.

• Synchronize Configuration

• Batch Import

• Export Audit Logs

• Change Diagnostic Logging Level

• Licensing the Software

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .S Y N C H R O N I Z E  C O N F I G U R A T I O N  ( P L U S  O N L Y )

For more information refer to section “Synchronize Configuration (Plus Only)” on page 24..

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B A T C H  I M P O R T  B U T T O N

The Batch Import utility allows you to upload valid cards into the PACS server where they can be regi stered into the PACS itself. A
network connection is required for this. 

Press the Batch Import button to display the Batch Import dialog. 
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The Batch Import utility will automatically refer to the directory containing the <stored>.dat files.

This directory was defined under the Configuration tab Configuration -> Plus -> Offline folder. For instructions to setup your offline folder 
location, see “Offline File Folder” on page 29.

Press the Test button to test the server connection to be sure you have connectivity.
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. .TO O L S
After you have tested the PACS Service, press the Start button to submit the cached credentials. Note that PKI validation is repeated.
This prevents PIVCheck Plus Mobile Edition from reg istering a card  for a cred ential that was revoked whi le the cred ential was in
temporary offline storage. When the upload is complete, the following message is displayed.

Press the OK button to clear the popup dialog, then the Cancel button to return to the Tools tab.

BATCH IMPORT FAILURE

I N C O M P A T I B L E  D A T A  F O R M A T S
If the batch import utility cannot submit cached cardholder certificates for registration, the Failure prompt dialog will appear.
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Problems with the batch import utility are often caused by an incompatibility between the data format of a PIV card and the data format of
the target PACS personnel record. The purpose of your data mapping file is to synchronize these two sources of data.

R E - V A L I D A T I O N  O F  C E R T I F I C A T E S

Batch import invokes the blacklist plug-ins configured at the se rver so that certificates that have been stored in the  credentials are re-
validated before importing the data record into the PACS.
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. .TO O L S
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .E X P O R T  A U D I T  L O G S  B U T T O N

This feature allows the user to convert the encrypted audit log to comma separated values (CSV) format.

AUDIT DATA ELEMENTS
Whenever a card is inserted and the PIN is matched, a new activity transaction begins. The following information is available for each
transaction:

• Start Date and Time

• TWIC Authentication Mode

• CHUID FASC-N

• Card Holder Name

• Expiration Date and Time  

• Number of PIN attempts (including first) 

• Verification Date and Time   

• CHUID Check Results (Ok, Bad, or Not Checked) 

• Biometric Comparison Results (Match, No Match, or Not Configured)

• TSA Hotlist Check Results (Not Found, Found, Not Configured, or Deferred) 

• PKI Validation Results (Good, Revoked, Not Configured, or Deferred)  

• Operator User Name

• Unit (System) ID (serial number)

• Stop Date and Time

• Overall Result (Authenticated, Not Authenticated)

If operating in online mode then audit records are sent to the server in real time. !
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UPLOAD TO SERVER (PLUS AND/OR AUDIT TRAIL ONLY)
If you are l icensed for PIVCheck Plus Mobile Edition or PIVCheck Audit Trail, you may choose the Upload to Server option. This wil l
decrypt the locally cached audit log and insert the records that into the Audit database that is managed by the PACS Service plug-in.

EXPORTING AUDIT LOG TO FLASH DRIVE
To decrypt the audit log and export it to a flash drive, insert a flash drive into one of the USB ports on the top of the terminal. Then tap the
Export Audit Logs button. Select the Export to File System radial button. Tap on the Browse button. A folder browser dialog box will be
displayed. Tap on Hard Disk. Then tap Select. When ready to begin the export, tap the Start button on the Export Audit Logs screen. 
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. .TO O L S
AUDIT LOG FILE CLEANUP
After the export to server or file is complete, you will be prompted to clear the existing audit file. It is recommended that before you tap
the Yes butto n, you remove the  flash drive cont aining th e exported log fi le and verify the files on  a PC. If the  file appears to be
complete and is not corrupted in any way then tap the Yes button. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C H A N G E  D I A G N O S T I C  L O G G I N G  L E V E L  B U T T O N

This is a n advanced feature designed to help debug cards that appear to be incompatible. In the event  PIVCheck Mobile Edition
encounters an error while reading the contents of a card, remove the card from the reader and set the logging level to Informational
and Debugging Messages. 
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Re-insert the card and repeat the operation that failed. Change the logging level back to Informational Messages Only. Then locate the
log file by tapping on the icon in the extreme lower right corner and switching to the Desktop. 

If your mobile boimetric termina l has a  USB port then insert a fl ash drive into the  USB port. T ap on My Device and navigate to the
following folder: Program Files -> Pivcheck_Mobile_Edition -> logs

An entry for the diagnostic log file should be displayed. 
64 Rev. 05262010



. .
 . 

. .TO O L S
From the Edit dropdown menu, tap Copy. 

Now, tap on the Up arrow on the Windows CE Explorer tool bar. 

Continue to tap the Up arrow until the contents of the uppermost level are displayed:
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Select Hard Disk to open the contents of the flash drive. Then, drop down the Edit menu. The Paste option will be enabled:

Tap on Paste. The log file should immediately appear: 

Remove the fla sh drive and insert it in to a PC. E-mail the lo g f ile as an attachment to  Cod ebench Technical Support for a nalysis.
techsupp@codebench.com

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .L I C E N S I N G  T H E  S O F T W A R E

For more information refer to section “Licensing the Software” on page 19..
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UPDATING YOUR SOFTWARE 9
Keeping PIVCheck Mobile Edition up to date and compliant with the latest rules and regulations is very important to us. Which is why
you should frequently check to ensure that you are running the latest version of your Codebench software.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .O V E R V I E W

There a re multipl e ways to upg rade to th e latest release of PIVCheck Mobile Edition. The method you  choose wil l depend upon
whether you have network connectivity and whether your software is properly licensed. 

• You can request PIVCheck Mobile Edition to upgrade the software.

• Use the Windows CE Internet Explorer to download the software and install it manually.

• Copy the software from a flash drive to the mobile biometric terminal and install it manually.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A U T O M A T I C  S O F T W A R E  D O W N L O A D

To use the this method, you must have an Internet connection and a licensed copy of the software with a revision level of 1.1.5.0 or
better. 

Remove any cards from the smart card reader then select the About tab.

Note that the version number in the lower right corner is a hyperlink. Click the link. The following dialog will be displayed.!
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Tap the Check for latest version button to see whether any updates are available.

If a newer version is available, it will be displayed as shown in the following illustration.
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. .U PD A T I N G  YO U R  S O FT W A R E
Tap the Download latest button to upgrade the software, and the following dialog will be displayed. Otherwise, tap Cancel to close the
dialog. When the download is complete, you will be prompted to allow the installer to close the current application instance. 

Since PIVCheck Mobile Edition is already installed you will be prompted to shutdown the application. Tap Yes to continue. 
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Tap the OK button to overwrite the current installation. (Your configuration settings will be preserved).  

Tap the OK button to proceed with the installation. The progress bar will appear to be truncated at both ends. This is normal Windows CE
behavior.  
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. .U PD A T I N G  YO U R  S O FT W A R E
I N S T A L L I N G  A N  E X E C U T A B L E  F I L E  V I A  I N T E R N E T  E X P L O R E R  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D O W N L O A D

To use  th is method , yo u must ha ve an Internet conn ection a nd a  user n ame a nd p assword to access the Co debench general
download site. If you have never used Internet Explorer from your mobile biometric terminal, it may need to be configured for Internet
access. 

Exit the PIVCheck Mobile Edition application.

Launch Internet Explorer and tap View.

Tap on Internet Options at the bottom.
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When the dialog appears, tap on the Connection tab. Check the Use LAN (no autodial) option.

If you are requi red to  use a proxy server then check the Access the Internet using a proxy server option and supply the addressing
information for your site.

Tap the OK button to save the configuration options.

Now you  are  rea dy to download a  ne w versio n o f software. T ype the following URL  in to the browser's address bar:
http://www.pivcheck.com/cabs/

An authentication dialog will be displayed. 
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. .U PD A T I N G  YO U R  S O FT W A R E
Enter your User Name and Password into the appropriate fields and tap the OK button. If the information is correct, then an options
dialog will be displayed: 

Choose the options as shown above and tap OK. The new PIVCheck Mobile Edition executable file will be downloaded to the \Temp
folder on the terminal. 

Tap the OK button to start the download. 
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When the file download is complete, close Internet Explorer and tap on My Device and navigate to the \Temp folder. 

Double-tap on the PIVCheckMobileEdition 1.X.XX.X.exe file and follow the installation wizard. 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I N S T A L L I N G  A N  E X E C U T A B L E  F I L E  F R O M  A  F L A S H  D R I V E

• Copy the executable file onto the flash drive. 

• Power up the mobile biometric terminal.

• Insert the flash drive into one of the standard USB ports. 

• Double-tap the My Device Icon. The flash drive will appear as a Hard Drive in this directory.

• Double-tap on the Hard Drive directory to reveal the PIVCheck Mobile Edition executable file. Copy the executable file from the 
My Device > Hard Disk directory to the My Device >Temp directory.

• Double-tap the executable file and follow the installation wizard.

This completes the installation.
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APPENDIX A A
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .R E F E R E N C E  D O C U M E N T S

1 Federal Information Processing Standard Publication 201-1 (FIPS 201-1): Personal Identity Verification (PIV) of Federal
Employees and Contractors, NIST, March, 2006

2 NIST PIV Program web site, http://csrc.nist.gov/piv-program

3 NIST Special Publication 800-63-1: Electronic Authentication Guideline: Recommendations of the National Institute of
Standards and Technology, February 2008.

4 NIST Special Publication 800-73-3: Interfaces for Personal Identity Verification – Part 1: End-Point PIV Card Application
Namespace, Data Model, and Representation, February 2010.

5 NIST Special Publication 800-73-3: Interfaces for Personal Identity Verification – Part 2: End-Point PIV Card Application Card
Command Interface, February 2010.

6 NIST Draft Special Publication 800-76-1: Biometric Data Specification for Personal Identity Verification, January 2007.

7 NIST Special Publication 800-78-2: Cryptographic Algorithms and Key Sizes for Personal identity Verification, February 2010.

8 NIST Special Publication 800-79-1 (SP 800-79-1): Guidelines for the Accreditation of Personal Identity Verification (PIV) Card
Issuers (PCI's), June 2008.

9 NIST Draft Special Publication 800-85 A-1 (SP 800-85 A-1): PIV Card Application and Middleware Interface Test Guidelines (SP
800-73-2 Compliance), March 2009

10 NIST Draft Special Publication 800-85 B (SP 800-85 B): PIV Data Model Test Guidelines, July 2006

11 NIST Draft Special Publication 800-85 B-1 (SP 800-85 B-1): DRAFT PIV Data Model Conformance Test Guidelines, September
11, 2009

12 NIST Draft Special Publication 800-87 Rev 1 (SP 800-87 Rev 1): Codes for Identification of Federal and Federally-Assisted
Organizations, April 2008.

13 NIST Special Publication 800-116: A Recommendation for the Use of PIV Credentials in Physical Access Control Systems
(PACS), November 2008.

14 TWIC Reader Hardware and Card Application Specification Version 1.1.1, May 2008

15 TWIC Technical Advisory TA-2008-TWIC001-V1.0, TWIC Reader Functionality Augmentation, September, 2008

16 TWIC Technical Advisory TA-2009-TWIC001-V1.0, Format for a TWIC Card with no Fingerprint Biometric Data, March, 2009

17 TWIC Technical Advisory TA-2009-TWIC002-V1.0 Additional Error Code Definitions for TWIC Cards, March, 2009

18 Smart Card Alliance Publication Number: PAC-07002: Physical Access Control System Migration Options for Using FIPS 201-1
Compliant Credentials, September 2007.
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APPENDIX B B
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C A R D  D A T A  C O N T A I N E R S

TABLE 1. PIV DATA CONTAINERS
Container Name Container ID Access Rule Contact / Contactless  Mandatory/Optional 

Card Capability Container 0xDB00 Always Read Contact Mandatory 

Card Holder Unique Identifier 0x3000 Always Read Contact & Contactlessa Man datory 

X.509 Certificate for PIV Authentication 0x0101 Always Read Contact Mandatory 

Cardholder Fingerprints 0x6010 PIN Contact Mandatory 

Security Object 0x9000 Always Read Contact Mandatory 

Cardholder Facial Image 0x6030 PIN Contact Optional 

Printed Information 0x3001 PIN Contact Optional 

X.509 Certificate for Digital Signature 0x0100 Always Read Contact Optional 

X.509 Certificate for Key Management 0x0102 Always Read Contact Optional 

X.509 Certificate for Card Authentication 0x0500 Always Read Contact / Contactless Optional 

Discovery Object 0x6050 Always Read Contact Optional

Key History Object 0x6060 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 1 0x1001 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 2 0x1002 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 3 0x1003 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 4 0x1004 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 5 0x1005 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 6 0x1006 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 7 0x1007 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 8 0x1008 Always Read Contact Optional
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Retired X.509 Certificate for Key 
Management 9 0x1009 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 10 0x100A Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 11 0x100B Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 12 0x100C Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 13 0x100D Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 14 0x100E Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 15 0x100F Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 16 0x1010 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 17 0x1011 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 18 0x1012 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 19 0x1013 Always Read Contact Optional

Retired X.509 Certificate for Key 
Management 20 0x1014 Always Read Contact Optional

Cardholder Iris Image 0x1015 PIN Contact Optional

a. In September 2007, this was changed from Contact to Contact & Contactless.
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TABLE 2. TWIC DATA CONTAINERS

Container Name Container ID Access Rule Contact / Contactless Mandatory/Optional 

TWIC Privacy Key Buffer 0xDFC101 
(0x2001)** Always Read Contact (and Magnetic 

stripe also) Mandatory

Card Holder Fingerprints 0xDFC103
(0x2003)** Always Read Contact & Contactless Mandatory

Card Holder Unique 
Identifier 

0x5FC102 
(0x3000)** Always Read Contact & Contactless Mandatory

Unsigned Card Holder 
Unique Identifier

0x5FC104
(0x3002)** Always Read Contact & Contactless Mandatory

Security Object 0xDFC10F 
(0x9000)** Always Read Contact & Contactless Mandatory
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OVERVIEW
The proximity reader included with the DSV2+Turbo  may ne ed to be configured to produce the correct bit sequence for the site's
proximity cards. This is done by removing the back cover of the DSV2+Turbo and reconnecting the proximity reader to a PC so that a
new configuration can be downloaded to its NVRAM.

PROCEDURE

P R E P A R I N G  T H E  R E A D E R
1 Download the configu ration uti lity from http://www.rfideas.com/Software/pcProxConfig.exe and install it on  a W indows XP

computer. Do not start the program yet.

2 Using a screw driver, remove the back cover from the DSV2+Turbo mobile terminal. 

3 Disconnect the USB cable from the built-in receptacle located between the battery pack and the pcProx reader.

4 Ensure that the DSV2+Turbo is powered down. 

5 Disconnect the USB connector between the pcProx reader and the USB extension on the DSV2+Turbo.

6 Carefully extend the two-i nch USB ca ble from the pcProx re ader and connect it to the PC. T he led on the pcProx reader will
display in red.

7 Start the p cProx configuration utility. It will immediately query the PC' s USB po rts to locate the pcProx reader. Cl ick the Set
Keystroke Data tab. 

F A C I L I T Y  A N D  I D  C O D E S

• From the a pplication menu, select File > Open… and se lect the fi le format fo r your site. Adjust the information in the F acility
(FAC) & ID Codes section to meet your site's requirements.

K E Y S T R O K E  D A T A

• In the keystroke data section, configure as shown in the following illustration:
When complete, click the Write to pcProx or AIR ID button.
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